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1 Introduction

Bria is a softphone from CounterPath that enables you to make VoIP voice and video calls, send and receive
instant messages, share online status (presence) information, and exchange files. Bria implements SIP-based
standards for phone calls, IM and presence, allowing you to work with different VoIP service providers. Bria
also uses XMPP-based standards for IM and presence.

Standard Telephone Features
The CounterPath Bria 3 for Mac softphone has all standard telephone features, including:
•
•
•
•
•
•
•
•
•
•

Call display and Message Waiting Indicator (MWI).
Speakerphone and Mute.
Redial, Hold, Do Not Disturb.
Call history – list of received, missed, and dialed calls.
Call forward.
Call transfer.
Call record.
Auto answer.
Six-party audio conferencing.
Three-party video conferencing.

Enhanced Features and Functions
Bria also supports the following features and functions:
•
•
•
•
•
•
•
•
•
•
•

Video
IM and presence using the SIP SIMPLE protocol or the XMPP protocol.
IM conferencing (group chat) via an XMPP account.
Corporate chat rooms.
Contact list containing the individual user’s contacts
Directory containing names from a shared LDAP directory.
File transfer via an XMPP account.
Automatic detection and configuration of audio and video devices.
Acoustic echo cancellation, automatic gain control, voice activity detection.
Support for DTMF (RFC 2833 or inband DTMF).
Support for the following audio codecs:
DVI4, DVI4 Wideband, G.711aLaw, G.711uLaw, G.722, G.729, GSM, iLBC, L16 PCM Wideband, Speex,
Speex FEC, Speex Wideband, Speex Wideband FEC.

•

Support for the following video codecs:
H.263, H.263+ 1998, H.264.
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•
•
•

•
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Automatic selection of the best codec based on the other party’s capability, the available bandwidth, and
network conditions. Bria switches the codec within a call in response to changing network conditions.
Compliance to 3261 SIP standard.
XMPP compliance as follows:
• RFC 3920
• RFC 3921
Supported extensions:
• XEP-0004
• XEP-0016
• XEP-0022
• XEP-0077
• XEP-0085
• XEP-0092
• XEP-0115
Support for these firewall traversal solutions: STUN, TURN, or ICE.

2 Installation and Setup

2.1 Getting Ready
Account Information
After choosing a VoIP service provider, you will need the following information:
•
•
•
•

User name and domain. For example, 1331@domainA.com
Password
Authorization Name (if applicable)
Firewall traversal and other network information; see “Configuring Bria” on page 47.

XMPP Accounts
If you use an XMPP service for instant messaging or presence, you will need the following information:
•
•
•

Jabber ID: user name and domain. For example, jsantos@domainXMPP.com.
Password
Connection information; see “XMPP Account” on page 49.

System Requirements
•
•

Operating System: Mac OS 10.5 or above.
Connection: IP network connection (broadband, LAN, wireless). Bria requires a continual internet
connection.

Multimedia Device Requirements
Bria requires both speakers and a microphone to make calls. Any of the following configurations are
acceptable:
•
•
•
•
•

External speakers and microphone
Built-in speakers and microphone
Dual-jack multimedia headset
USB multimedia headset
USB phone.

Bria is optimized to work with Apple iSight camera.

3

CounterPath Corporation

2.2 Configuring Bria
First-time Startup
If Bria is not already running, start it as you would any other program. The Bria Login dialog appears with the
Profile set to “Manually configure login server”.

Set the profile to “No login required” and click Continue. The softphone GUI appears. (Login is used only in
enterprise deployments in which a system administrator has set up a provisioning server to automatically
configure Bria for you.)

Subsequent Startups
After the first-time startup, the Bria Login dialog will not appear if you selected the No login required profile.
(If you started up the first time with “No login required” but in fact you do need to log in, go to the menu and
choose Preferences. Click the Application tab and enable login. See page 61.)

Setting up Accounts
After obtaining SIP account information from your VoIP service provider, you can set up Bria accounts.
1. From the menu bar, choose Bria > Preferences > Accounts. The Account list appears with one account (the
Mac Address Book account) enabled; see below.
Set up the SIP Account

2. Click the + button and choose New SIP Account. The SIP Account window opens.
3. In the General tab, complete the User Details area with the information obtained from your VoIP service
provider.
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4. Complete the remaining tabs as specified by your service provider or to suit your setup. Settings that you
may need to change immediately include:
• General tab, Domain Proxy area.
• Topology tab, if your computer is on a network and/or behind a firewall.
For more information, see page 50.
5. Click OK; the account is enabled and registered; check the account list to make sure the account registers
successfully.
Set up the XMPP Account

If you already have an XMPP account independent of Bria (for example, a Gmail™ webmail service account),
you can create an account in Bria and pull your contacts into the Bria contact list. You can then IM these
contacts directly from Bria.
6. Click the + symbol at the bottom of the window and choose New XMPP Account. The XMPP Account
window opens.
7. Complete the window with the information obtained from the XMPP service provider. Typically you only
have to complete the User Details. For more information, see page 49.
8. Click OK. In a few seconds you will see all the existing contacts from your XMPP account appear in the
Bria contact list, in a new group.
9. Make sure the Status is green for all accounts.
Enable your Mac Address Book Account

If you want to pull in the contacts from your Mac Address Book, enable the Mac Address Book account. See
page 47 for more information.
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Setting up for Voicemail
Your VoIP service provider may offer voicemail. If it does, then you can set up some voicemail features in Bria.
See page 52.

Populating your Contact List
Typically, you will want to create contacts in order to easily make phone calls, send IMs and transfer files. You
can bring in contacts from other sources:
•
•

From a file such as a vCard or comma-separated-values (CSV) file. See page 33.
From your Mac Address book, by enabling the Mac Address Book account. See page 47.

.In addition:
•
•

During a call that you place or receive, you can add the other party to your contact list. See “Handling an
Established Call” on page 16.
You can add addresses to the Contact list one by one. See page 34.

For general information on contacts, see page 31.
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2.3 Troubleshooting
Bria includes tools for helping you troubleshoot problems. From the menu, choose Help > Troubleshooting.
•
•
•
•
•

Audio tab: While you are on a phone call, you can test the quality of the audio. Note that to perform a valid
test, you should be on an established call (not a call attempt).
Video tab: You can verify that your camera is working.
Network tab: You can verify that you are successfully connected to the network.
Devices tab: You can verify that your microphone and speakers are working and can set the volume to a
comfortable level without having to actually place a phone call.
Diagnostics tab: If none of the other tabs help you solve your problem.

2.4 Checking for Bria Updates
To check for updates to Bria, from the menu bar, choose Help > Check for updates. The Auto Update window
appears.
•
•

If a new version of the software is available, you can download it from this window.
If no newer version is available, this window informs you that your version is up to date.
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3 Making Phone Calls

3.1 The Onscreen Softphone
Minimize to dock
Close window
The dashboard
menu

Show/hide dial pad
The Call button
Call entry field
See page 11.

Resources.
See page 45

Resize softphone

Compact View

To display a compact view of the softphone, hide the dialpad and hide all the resources tabs (View > Hide).
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The Bria Menu

The menu contains the following items that are specific to Bria:
•
•
•
•
•

Bria > Preferences. See page 61.
View. Changes how Bria looks. Also lets you view the message archive and chat rooms (if you are a
member of one; see page 29).
Contacts. Lets you work with contacts.
Actions. Lists the actions that you can perform, depending on the current “state” of Bria. For example, if a
contact is selected, it lists all the actions that can be performed on that contact.
Help. Provides access to various service-related features.

The Bria Toolbar
The toolbar has various buttons, including the message waiting indicator (MWI) and missed calls indicator.
Hover over each button for a description.

Receiving an Online Status Request
When you start Bria, one of the first things you may see (if presence is enabled) is an Online Status Request
dialog. See “Sharing Online Status” on page 39.
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3.2 Placing a Call
Place the call as described in the table below. The outgoing call opens in its own call panel, below any other
existing call panels. You will hear a ringing tone while Bria attempts to make a connection.
Option
Keying

From the...
Dialpad or computer
keyboard

Description
1. Enter the number or address in the call entry field using the dialpad
or the computer keyboard. To turn letters to numbers, see page 13.
If entering a softphone address, you can enter the entire address
(6045551212@domainA.com) or just the number (6045551212).
As you type, a suggestion for completing the entry may appear.
Choose the suggestion or keep typing.
2. Click the Call button or press Enter.

Drag-and-drop contact or Contacts or History tab
previous call

Drag an entry from the Contacts or History tab. (If the tab contains lots
of contacts, first search or filter the list.)

Control-click a contact or Contacts or History tab
previous call

Control-click an entry from the Contacts or History tab and choose Call
or Video Call.
(If the tab contains lots of entries, first search or filter the list.)

Single-click a contact

Contacts tab

Hover over the right side of the contact to reveal the click-to-call
button. Click to place a call using the primary phone number for this
contact.

Redial

Redial button

• When the call entry field is empty, click the Call button.
• Or click the arrow in the call entry field and select a recent call.
An audio call is placed.

Dialing

Dialpad

From an instant message IM window

1. If the dialpad is not visible, click the Show/Hide dialpad button.
2. Click the numbers on the dialpad to enter the phone number.
3. Click the Call button or press Enter.
Click the menu at the top of the IM window and choose Call.

See the next page for an example.

11

CounterPath Corporation

Call entry field

Click to place the call
Auto complete suggestions

For information on working with
the call, see “Handling an
Established Call” on page 16.

Dealing with an Auto Attendant

If you know that your call will be answered by an auto attendant and you know what menu items you will
choose, you can include those menu items (DTMF) in the phone number when you dial it:
•
•
•

Before the first DTMF number, include at least one capital P.
You can include other Ps. Each P causes Bria to wait one second before sending the next character.
At the end of the input, you must include a ; character.

Example: To dial a number, add a 3-second delay and then press 44, enter this in the call entry field:
604551212PPP44;

Example: To dial a number, add a 6-second delay, then press 1 then 3 then 2, each with a two second delay:
604551212PPPPPP1PP3PP2;
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Selecting the Account to Use
This information applies only if you have more than one SIP account set up and enabled.
When you place a call, you can explicitly specify the account to use for that call.
The account selection options appear only if you have two or more SIP accounts that are enabled and being used
for phone calls. To make an account “useable” for phone calls, from the menu bar, choose Bria > Preferences >
Accounts, open the desired account and change the Use For fields on the General tab (page 47).
Choose the account to use.
If you choose Auto Select, then the
account to use depends on your dial plan
rules (page 50). If there are no dial plan
rules, then the “preferred” account
(page 47) is used.

This account will be used for all
calls until you select a different
account or go back to Auto Select

Letters to Numbers
You can type letters and Bria will convert the letters to numbers when placing the call:
Turn letters-to-numbers on or off
Type the phone number
using numbers and letters,
as desired

When you click Call, the call panel will open and
the call will be placed. The call panel will show the
phone number all in digits.
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Hiding your Identity (Anonymous Calling)
You can hide your identity on a call, so that the other person will not see your name or number on their phone.
Your ID will be hidden for all outgoing calls until you turn off Hide my number mode
Anonymous Calling is automatically turned off when you shut down.
Turn Hide my number on or off

Placing another Call
You can place another call. There is no limit to the number of calls you can make, although eventually the
quality of audio and video will degrade because of limitations on the computer.
Place the call in
the usual way

Existing call is automatically
put on hold

New outgoing call

Switch between the different
calls by clicking Resume on the
desired call panel. That call
becomes the active call and all
other calls are on hold.
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3.3 Handling Incoming Calls
Bria must be running to answer incoming calls. (If Bria is not running, incoming calls may be directed to
voicemail; check with your VoIP service provider.)
The new call appears in its own call panel. In addition, the Call Alert box appears, even if Bria is minimized.
For information on call alerts, see page 63.

Click. If you are on another call, that first
call is automatically put on hold. You are
now talking to the new caller.

Or click Forward; a call entry field
appears. Enter the name or number to
forward to and click Forward Now.

Or click. There will be a busy signal. The
call may be directed to voicemail (if you
have this service).
This is the alert for a video call

This is the alert for an audio-only call

Click to answer a video call and
start sending your video
immediately

Click to answer without video; if you
want (and if you have a camera), you
will be able to add video later.

Auto Answer
You can set Bria to automatically answer all incoming calls.
Turn Auto Answer on or off
Auto answer is initially configured to auto-answer after one
ring, and to send only your audio when the call is
established. To change this configuration choose
Preferences > Call Automation.
Auto answer is automatically turned off when you shut
down.
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3.4 Handling an Established Call
Place another call

Audio Controls

The current call is automatically
put on hold). See page 14

Speakerphone

Speaker control, microphone
control and mute

Voicemail
See page 24

Add as Contact
If a plus symbol appears here,
you can add the current caller as
a contact. See “Adding a
Contact using an Existing
Address” on page 37.

Transfer. See page 17

Video. See page 19
Conference Calls
See page 21
Instant Message
See page 25
Record the call

Ending a Call
Click the End call button on the Call panel (the call can be active or on hold). The call panel closes after a few
seconds.
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3.5 Transfering a Call
Basic (Unattended) Transfer – Transfer this Call
Click the Transfer button

The call is put on hold and a call entry field appears.

Type a name or number, or drag a
contact into the field.
Then click Transfer

The call may end immediately.
Or it may show “calling”, In this case, do
not hang up immediately: if the other
person does not answer, the call will
come back to you.
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Attended Transfer – Call then Transfer
You can first speak to the target (the person you are transfering the call to), then click Transfer to complete the
transfer.
Click the Transfer button

The call is put on hold and a call entry field appears

Or you can cancel the transfer request
and return to the first call

Type a name or number, or drag a contact
into the field
Then click Call

You can hang up the
second call and
return to the first call

Bria phones the
new person

When the other person answers, the
Transfer Now button is enabled

When you are ready, click
Transfer Now. The call panel
closes

18

Or if the other person does not want to
take the call, click Cancel and return to
the first call
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3.6 Handling Video Calls
Placing a Video Call
From the Dashboard

Click the down arrow and choose Video call.
If you mostly make video calls, you can
Option-click this down arrow to reveal the “Set
Video Call as default action” menu item.

From the Contact List or History

Choose Video Call

Adding Video
If you have a camera, you can click Start Video to add video to an established call. When you add video, the
other party may (or may not) start sending their video to you.

Other Party Adds Video
If the other party starts their video, your video panel automatically opens and the video is played. You can start
sending your own video, if desired (and assuming you have a camera) by clicking Start Video on the call panel.
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Pausing and Resuming Video
Click Stop Video on the call panel or close the video window to pause sending your video.
Click Start Video to resume sending your video; the video window will open.
Show/hide video window

Start or stop video
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3.7 Conference Calls
Starting a Conference Call
From the Dashboard

• Enter the number or address
by typing
• Or drag a contact or history
item
• Or select from the redial list
Then choose Start conference call

From an Existing Call
From One Established Call

From Two Established Call
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Managing the Conference
Mute. When you mute during a video call, you may also
want to click Stop Video to stop the video feed.

Participant menu

Conference call menu

Adding More Participants
You can add more participants to an existing conference in any of these ways:
•
•
•

Control-click on a contact and choose Add to Conference Call.
In the conference call panel, enter a name in the call entry field and click Add.
Add in a separate call that is not part of the conference call: In the call panel for the individual call, click the
down arrow and choose Merge Calls. This call is added to the conference call.

Send an Instant Message
Click the down arrow beside a participant name and choose Send Instant Message.

Removing a Participant
To remove one call from the conference, click the down arrow beside a participant name and choose Separate.
The call becomes a separate call.

Ending the Conference
To hang up on everyone, click the End button.

Suspending the Conference
To suspend the conference, click the Hold button. All participants are put on hold.
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Video Conference Calls
“Video” appears beside each person you are
currently sending video to
To start or stop video for one person, use the
participant menu

Closing the video window stops
sending video.

Start and stop sending your video to all participants

Starting a Conference with Video
When you start a conference from established calls, video is included if at least one of the calls already includes
video. Video is sent to all the participants.
When you start a conference from scratch, video is not included. You can open your video window and choose
to add video at any time. Video is sent to all the participants.

How Video Is Shared
The conference host (the person who starts the conference) serves as the host for other video. Whatever the
conference host is receiving will automatically be sent to the other parties.
If the conference host pauses or stops video, other participants will no longer receive video.
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3.8 Voicemail
If your service includes voicemail and you have set up voicemail options (page 52), then when you have
voicemail messages, the voicemail icon appears at the top of the phone (the icon may include a number). You
can click the icon to automatically connect to voicemail and listen to your messages.
Voicemail icon

3.9 Forwarding Calls
You can enable or disable forwarding so that calls will be forwarded to another number. You can set up
forwarding so that calls are always forwarded or so that calls are forwarded only when you are on another call.
To enable forwarding, from the menu bar, choose Bria > Preferences > Accounts. Open an account and click the
Voicemail tab. For complete details, see page 52.
You can also forward a call “on the fly”. See page 15.
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4 Other Bria Features

4.1 Instant Messaging
Sending an IM
1. There are several ways to select the person to send an IM to.
From the Contacts tab

Control-click on the contact and choose Send IM. The contact must have a softphone
address.
Or click on the IM icon that appears to the right of the contact name.

An active phone call

If the person is a contact, choose Send Instant Message from the call panel menu.

An active conference call

If the participant is a contact, choose Send Instant Message from the participant menu.

2. Type the message. Include emoticons and formatting, as desired.
To insert a return in the message, press Ctrl+Enter. (You can control the behavior of Enter and of
Ctrl+Enter; see page 61.)
3. Press Enter.

Click to select more actions

Message input area

Receiving an IM
When an IM is received, either the IM window or a Call Alert pops up. (To control which window appears, from
the menu choose Bria > Preferences > Application.)
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4.2 Sending a Broadcast IM
You can send an IM to several people at one time. A broadcast IM is not a conference IM.
•
•
1.

With a broadcast IM, each recipient can reply to the IM, but only you will see these replies; the other
recipients will not see these replies.
With a conference IM, all parties see everyone’s messages and the messages each party sends are seen by
everyone. See “Group Chat (Conference IM)” on page 27.
Select two or more contacts.

2. Control-click and choose Broadcast Instant Message. The Broadcast Instant Message window appears.
Click to add more contacts, if desired. Shows the display names of all the selected
contacts and the individual display names of all the contacts in any selected groups.
Contacts that do not have a softphone address are not included in the list.

3. Type the message. Include emoticons and formatting, as desired.
4. Press Send or Enter. The IM is sent.
A recipient may send you a response, which will be displayed to you in a regular Instant Message window;
you will then be in a regular IM with that one party.
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4.3 Group Chat (Conference IM)
Group chat allows you to exchange instant messages with a group of people in the same session. All people
must have XMPP accounts configured in order to participate in group chat.
Group chat differs from a broadcast IM in that all parties see everyone’s messages, and the messages each party
sends are seen by everyone else. In a broadcast IM, each recipient can reply to the IM, but only the person who
sent the broadcast IM will see these replies; the other recipients will not see these replies.
There is no limit to the number of participants in a group chat. You can also invite more participants during a
group chat session.
1. In the Contacts tab, select the desired contacts. Contacts must be online.
2. Control-click the last selected contact and choose Start Group Chat. The invitation dialog appears.

3. Change the message, if desired, and click Invite. The Group Chat window appears.

To invite more participants, click
here and select contacts from
the list that appears.

To remove a participant, select
the participant and click here

Leaving a Group Chat
To leave group chat, close the group chat window.
If you have started the group chat and you leave the session, the session continues with the remaining
participants.
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Rejoining a Group Chat
If you leave a group chat, you will be able to rejoin it so long as the session is still active (at least one other
person is in the chat).
1. View > Chat Rooms. Even if you do not normally belong to any chatrooms (next page), the chatroom
popup appears to show you the group chats you had joined that are still open.
2. Select this group. The Group Chat window reappears.

This is a group chat that you were in and that is still open
with other people.
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4.4 Chat Rooms
Typically, chat rooms are used only in enterprises and are set up by the system administrator.

4.5 Viewing the Message Archive
You can view your recent IM activity for any contact or group chat session.
Control-click a contact and choose View Message Archive.
Or go to the menu bar and choose View > Message Archive.
Select your own name to view your
group chat and chat room sessions
Select another person to view
instant messages with that person
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4.6 Sending and Receiving Files
Sending Files
If you have an XMPP account, you can send files to another contact who has a Jabber address (meaning that
they have an XMPP account).
1. Control-click a contact and choose Send Files; a standard Open dialog box opens.
2. Select the files to send and click Open. The Send Files dialog appears with a “waiting” message. If you
want, you can cancel the send before the other person retrieves the file.

To cancel the file transfer before the other person retrieves the files, click Cancel.

Receiving Files
If you have an XMPP account, another person with an XMPP address may send you files. The following dialog
appears, to allow you to save the file.

30

5 The Contacts Tab

The Contacts tab displays your contacts. Each contact is shown with presence information and icons for singleclick phoning and IMing.
If the Contacts tab is not showing, go to the menu bar and choose View > Show Contacts.

Add a Contact

Search field

Contacts are typically organized into
groups. Bria includes built-in groups. Yo
can add more groups, as desired.

The online status of
contacts. See
page 39.

You can change the detail and layout of the contact list: from the menu bar choose Contacts and set the desired
options.
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5.1 Populating the Contact List
At any time, but particularly when you first deploy Bria, you may want to populate the contact list with contacts
from an external source.

Populating from the Mac Address Book
You can populate the Bria contact list by pulling in the contacts from your Mac Address book.
Enabling the Mac Address Book

Enable the Mac Address book account that is has automatically set up in Bria. See “Configuring Accounts: the
Accounts Tab” on page 47 for more information.
Setting up for Availability

If your Mac Address book contains phone numbers that you know you can use to obtain online availability
information about the person via your SIP account, you can perform this optional setup:
•

In the Mac Address book, modify the contact’s entry so that the type is “Phone” and the label is “softphone”
(all lower case):

Address type “Phone”
Address label “softphone”

When you enable the Mac Address Book account in Bria, the contact will be pulled in with the specified
phone number already set up as a softphone address.
•

32

Open the contact and choose the specified phone number in the Presence field. When you click OK, Bria
will obtain availability information for this contact.
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Populating by Importing Contacts
You can populate the Bria contact list by importing from an external file or files. The new contacts will be
added to the existing contacts.
Importing

You can import a contact list from:
•
•

CSV A comma-separated file. Use this method to import from a Microsoft® Excel® file. You will first
have to set up the file; see below.
vCard. A vCard file (*.vcf file). A vCard is an electronic business card that is often attached to an e-mail.

1. From the menu bar, choose Contacts > Import Contacts. The Import Contacts wizard starts.
2. Select the file type and file location, and specify whether you want to replace or append to the existing
contact list.
Setting up an Excel File for Import

1. Remove any introductory text or headings from the top of the file. (You can keep text at the end of the file;
it will be ignored during the import.)
2. Insert a blank row as the first row, then insert the headings that Bria will use to interpret the meaning of
each column. The columns can be in any order. Key headings are:
•

sip-address. Bria recognizes a value in this column as a softphone address and considers the address as
one that can be phoned and as an address that can be used for IM/presence (if SIP is being used for IM/
presence).
• xmpp-address. Bria recognizes a value in this field as a Jabber (XMPP) address and will map this field
to the Instant Message contact method for the contact. Bria considers a Jabber address as one that can
be used for IM/presence (if XMPP is being used for IM/presence).
• display-name, given_name, surname
• business number
• presence_subscription. Complete this column in one of these ways:
• If you only want to share presence information with some of your contacts, fill in this column in
the file. Enter “true” for contacts whose online presence you want to see, leave blank or enter
“false” for others. During the import, you will be able to choose to share presence with only these
contacts. Bria will subscribe to the presence of these “true” contacts, assuming that the user has a
SIP (if using SIP for presence).
• If you want to share presence with all your contacts (or with none), ignore this heading. During the
import you will be able to choose to share with all (or none) of your contacts.
For a complete list of headings, see “Contact List Headings” on page 84.
3. Save the file as *.csv.
Exporting Contacts

You can export a contact list to a comma-separated file.
1. From the menu bar, choose Contacts > Export Contacts. The Export Contacts wizard starts.
2. Select the file type and file location for the created file.
A file of the specified type is created.
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5.2 Managing Contacts and Groups
Adding a Contact
Click

, or control-click a group and choose Add Contact to Group. The Contact dialog appears.

To enter a phone number, select
the type, enter the number, and
click +

The new number appears
in the list

Field

Description

Contact Summary
Group

Click to show the list of groups. Check each group this contact should belong to.

Primary Call

If the contact has more than one number, select the primary number. This number will be used with
single-click calling.

Primary Presence

This field appears only the contact has more than one Softphone number or Instant Message address.
The primary presence is used as follows:
• The presence icon on the contact list shows the online status for this address.
• The single-click action for instant messaging uses this address.
You can still send IMs to this person at their other addresses, but you must right-click and choose
from the context menu.

Other Sections
Display Name (required)

The display name for this source of information. For example, the display name from the XMPP
contact list.

First Name, Last Name

Optional.

Contact Methods

Enter as many contact methods as you want.
Enter a person’s IM address as follows:
• If you use the SIP account for IM and presence, choose Softphone.
• If you use a XMPP account for IM and presence, choose Instant Message.
If you have more than one account of a given type, include the domain (for example,
1440@domainA.com) to ensure that the number or address gets associated with the correct account.

Presence
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This field is automatically populated when you enter an address in the Softphone or Instant Message
field. It indicates that you are sharing online presence information using this address. The address is
also shown in the list in the Primary presence field, above.
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Example – Contact with a Softphone Number

This example shows how to add a contact when your VoIP service supports online availability via your SIP
account.
Enter the person’s softphone number in
the Softphone field

As soon as you add a Softphone entry, this field
automatically appears. Bria will share online presence
information with this person using this phone number.

In addition, these fields appear. See the table for
information on these fields.
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Example – Contact with an XMPP Address

This example shows how to add a contact who has an XMPP address (for example, a Gmail address). Assuming
you have created a corresponding XMPP account in Bria (for example, an XMPP account for your Gmail
address), then you can send this person IMs and share online status.

Enter the XMPP address
in the Instant Message
field. Include the domain
(e.g. @gmail.com)

Enter the person’s phone
number and any other
information

Select the Instant Message
entry; the Enable XMPP
Presence button appears
Click the button

All the XMPP information moves
to a separate section. This XMPP
information is automatically
added to your list of contacts on
the XMPP server (for example, to
your Gmail list)
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Adding a Contact using an Existing Address
You can add a contact by capturing existing information:
•
•

If you are on a phone call with a person who is not a contact, click the Add to Contacts icon in the call
panel.
On the History tab, select an entry that is not a contact. Control-click and choose Add Contact.

The Contact Profile dialog appears. Complete the dialog as desired and press OK.
If the contact method is Softphone or Instant Message, an online status request is sent to this person. See
“Sharing Online Status” on page 39.

Modifying the Contact List
Changing Contact Information

To change the information for a contact, control-click the contact and choose Edit Profile. The Contact dialog
appears (see page 34).
Moving or Deleting a Contact

•
•

To drag one or more contacts to a different group, select them and drag to the title bar of the new group.
To delete one or more contacts, select them, control-click, and choose Delete or Delete Selected Items. The
contacts are removed from this group. If a contact belongs to several groups, it is removed from all groups.

Adding, Deleting or Renaming Groups

Select any group, control-click, and choose the appropriate menu item.
Contacts that have no group appear under “Ungrouped Contacts.” You can delete, but not rename, this group.
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5.3 Using Contacts

Hover to reveal icons. Click the
phone icon to call using the
primary phone number. Or click
the IM icon to send an IM using
the primary presence address
for this contact.

You can watch the contact’s online
status, if the contact has a softphone
address.
See page 41 for the meaning of the
online status icons.
See “Sharing Online Status” on
page 39 for information on obtaining
online status information.

See page 25
See page 27
See page 29
See page 42
See page 62
See page 46
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5.4 Sharing Online Status
You can publish your online status to contacts who have softphone address, and you can set up Bria to view the
online status of other contacts. Typical online statuses are available, on the phone, busy, and so on.
Online status of other people
Your online status

This person has no icon
because you are not
subscribing to their online
status

This person is either logged out
or is not publishing their online
status

Sharing Online Status
Watching Others’ Status
To watch a contact’s status, that contact must be tagged for presence:
•
•
•
•
•

If you create a contact via the Contact Profile and you include a SIP address in the Softphone field, Bria
will automatically obtain status information for this address.
If you create a contact via the Contact Profile and you include an XMPP address, you can click the Enable
XMPP Presence button to obtain status information for this address.
If you created contacts by importing a contact list, you can specify during the import whether you want to
share presence information. See page 33.
If you created an XMPP account in order to pull in your Gmail contacts, these contacts will already be set
up to share status information.
If you enabled the Mac Address Book account in order to pullyour Mac contacts into Bria, then these
contacts will be set up for presence if you set up the mapping correctly. See page 32.

When you choose to share presence information, Bria sends the contact a notification request. The request asks
that you be able to see that person’s status. If the person allows this request, then the icon beside their name (in
your Contacts) becomes color coded to specify their status.
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Allowing Other Parties to See your Status (Publishing your Status)
Continuing from above, when the other person allows the notification request, your name is added to their
contact list. As soon as you are added to their list, a request is sent back to you requesting that they be able to
see you. Bria accepts this request automatically, and the other person can now see your status.

Receiving an Online Status Request
Someone who is not one of your contacts may add you as a contact on their end, and may include your SIP
address or XMPP address. In this case, Bria receives an online status request. The request is handled in one of
two ways:
•
•

If you set up a privacy rule before this person has a chance to contact you, then you will never see this
request. Bria will automatically reply to the request according to the rule. See page 62.
If you do not yet have a privacy rule set up for this person or for their domain, this request appears to you as
an Online Status Request. You must respond to the request:

Option

Button

Comment

Result

Create a new
contact

Allow

This option is selected for you if
you do not currently have a
contact with this SIP or XMPP
address.

Allow the request and create a new contact using this address.

Update an
Allow
existing contact

Either option

Block

This option is selected for you if
you already have a contact with
this SIP or XMPP address but
you were not previously sharing
your online status with this
person.

Because you allow the request, you will no longer be bothered by
requests from this person. In addition, this same request will
automatically be sent from your Bria to the other person, so that
you can see their online status.
Allow the request and add this address to an existing contact (if
Bria has found an appropriate match).
Because you allow the request, you will no longer be bothered by
requests from this person. In addition, this same request will
automatically be sent from your Bria to the other person, so that
you can see their online status.
Block the request.
This person will not be able to contact you from this address.

Either option

Ignore

Ignore the request.
The other person will not be able to see your online status. The
other person will not be added to your privacy settings.
The Online Status Request may appear again in this session or a
future session.

40

Bria 3 for Mac User Guide – Retail Deployments

Setting your Online Status
Changing your Status
Click the down arrow beside the online status indicator on Bria, and select the desired value. See the table
below.

Setting up Online Status Indicators
Indicator
Available

Meaning for your Status
Either:

Meaning for Others’ Status
You can contact this person.

• You have set your status to this value.
• Bria has determined that you are logged on but not on the
phone or idle.
When you have this status, Bria will automatically detect when
you are idle or on the phone, and change the status to match.
Busy

You have set your status to this value. Bria will never
automatically switch you out of this status; you must switch
yourself.

You can contact this person.

Away

You have set your status to this value. Bria will never
automatically switch you out of this status; you must switch
yourself.

You can contact this person.

On the phone

Either:

You can contact this person.

• You have set your status to this value. In this case, Bria will
never automatically switch you out of this status; you must
switch yourself.
• You started a phone call when your status was “Available”.
When your call finishes, your status reverts to “Available”.
Idle

You have not moved or clicked the mouse or pressed a
keyboard key for the Idle period. To set the Idle period see
page 61.

You can contact this person.

As soon as you click the mouse or keyboard, your status
changes to “Available”.
Offline

You have set your status to this value. The other person sees
you as offline, even though you are not actually offline. The
other person cannot tell the difference between this status and
you really being offline.

The contact is either not logged on or does
not want to share online status.

No icon

Not applicable

You are not watching the other person’s
online status.
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Adding Contacts to the Alert List (Buddy Pounce)
You can add a contact to the Alert List in order to request to be notified when the online status of a contact
changes.
In the contact list, control-click the selected contact or contacts and choose Add to Alert List. The Alert List
icon appears beside the contact.

When the contact’s status changes, a notification appears.
The time at which the contact’s
status changed

Click to phone or IM this person

Click to keep the contact on the alert list; the next time the
contact’s status changes, another notification will appear.
Or leave uncheck to stop receiving notifications for this
person.
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5.5 Privacy
You can control how contacts and other people can contact you by phone or IM, and you can control whether
your contacts can see your availability information (whether you are online, one the phone, and so on).
You can set up controls in advance or “on the fly” (as phone calls and presence requests come in).

Setting up Controls in Advance
To set up controls in advance, see “Preferences – Privacy” on page 62.

Setting up Controls “on the Fly”
Via the Online Status Request

Another party can send you a presence request, to request that they be able to see your presence, as described on
page 10.
Your response has the following effect on privacy:
•
•
•

If you add the person as a contact, then the ability of that person to phone or IM you is controlled by your
privacy settings.
If you allow the person without adding them as a contact, then the ability of that person to phone or IM you
is controlled by your privacy settings.
If you block the person, then that person is added to your Blocked List (Bria > Preferences > Privacy). The
person will not be able to phone or IM you, and will not see your availability information. You can change
this blocking by removing the person from the Blocked List, in which case they will then be controlled by
your privacy settings.

For information on privacy settings and the Blocked List, see page 62.
From the Contact List or History List

Control-click on the name and choose Block this Person. The person will be added to your Blocked List
(page 62). The person will not be able to phone or IM you, and will not see your availability information.
To later unblock this person, control-click on the name and choose Unblock this Person.
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6 Using Other Resources

6.1 The History Tab

Incoming missed call
Outgoing call, either
attempted or established
Incoming call that was
answered

From the menu bar, choose View > Show History.

Managing the List of Calls
You can control-click on an entry in a list to:
•
•
•
•

Delete the call.
Delete all entries in this list.
Edit the profile if the entry is a contact.
Add as contact. The Contact dialog appears. See “Adding a Contact using an Existing Address” on page 37.

Phoning from History
You can control-click on an entry to place a call to this person, using the contact method that was used for this
call. You can:
•
•

Control-click on an entry and select Call or Video Call to place a call to this person, using the contact
method that was used for this call.
Place a call to this person and add them to a conference call that is in progress. For more information on
conference calls, see page 21.
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6.2 The Favorites Tab
To view the Favorites tab go to the menu bar and choose View > Show Favorites.
You can create favorites from your contact list. They will be displayed in both the contact list and in the
Favorites tab.
Select the desired contacts, then control-click and choose Add to Favorites.

Quick links to IM or phone this person
Menu for other actions
You can perform nearly all the
same actions on the contact in
Favorites as you can in the contact
list.

Removes from Favorites but does
not remove from the contact list
Removes from Favorites and the
contact list
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7 Configuring Bria

From the menu bar, choose Bria > Preferences. The Preferences window appears.
•
•

When configuring Bria the first time, click the Accounts tab and set up the account. Then complete other
tabs as desired.
After the initial setup, display whichever tab you want.

7.1 Configuring Accounts: the Accounts Tab
Choose Bria > Account Settings from the menu bar. The Account Settings window appears, showing all the
accounts set up. From this window you can add (create), enable or disable, edit, or remove a SIP, XMPP or Mac
Address Book account.
Here is a typical setup
Your main SIP account
Another SIP account
Your own Gmail account
The Mac Address Book account, which is automatically
created but initially disabled

Double-click an account to
view or edit

This account will be used for calls if Auto Select is used
(page 13) and there are no dial plan rules for selecting
the account

You can:
•

Create a SIP account. Follow the instructions you obtained from your VoIP service provider. See page 50
and following.
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•

•

Create an XMPP account, if appropriate. For example, if you already have an XMPP account independent
of Bria (for example, a Gmail account), you can create an account in Bria and pull your contacts into the
Bria contact list. You can then IM these contacts directly from Bria. To create an XMPP account, see
page 49.
Enable the Mac Address Book account, if desired. Your Mac Address Book contacts will be automatically
pulled into your Bria contact list so that you can easily phone and IM them.

The account is the “preferred account” for the action specified in the column heading.
The account can be used for phone calls by selecting it on the dashboard (page 13)
The account cannot be used for phone calls.
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XMPP Account
You create an XMPP account if, for example, you already have an XMPP account independent of Bria (for
example, a Gmail account).

Fields with a red asterisk are required

Table 1: XMPP Account Properties – Account
Field
Account name
Protocol

Description
If desired, change the account name to something that is meaningful to you. For example, the
type of XMPP account such as “Gmail account”.
Read-only. Always specifies XMPP.

User Details
User ID
Domain
Password
Display name

The XMPP (Jabber) user ID. For example, jsantos. Provided by the XMPP service provider.
For example, domainXMPP.com. Provided by the XMPP service provider.
Provided by the XMPP service provider.
This name is displayed in the Bria display. Other parties may see this name when they are
connected to you.

Advanced
Port selection
Connect port
Outbound proxy

Resource

Priority

Configures the port to use. If you choose “User selected”, complete the Connect port field.
Complete only if Port selection is set to “User selected”
The value in User ID and in this setting may be used by Bria to compose a valid jid:
• If User ID=bob@ABC.com and Outbound proxy is empty, jid=User ID: bob@ABC.com
• If User ID=bob@ABC.com/home and Outbound proxy is empty, jid=User ID:
bob@ABC.com
• If User ID=bob@ABC.com and Outbound proxy=XYZ.com, ignore the Outbound proxy;
User ID=bob@ABC.com
• If User ID=bob@ABC.com and Outbound proxy=IP address or host address, jid=User ID.
(IP address is used as the outbound proxy).
• If User ID=bob and Outbound proxy=ABC.com, jid=bob@ABC.com.
Optional resource, as specified in RFC 3920. For example “/home”. If this setting is blank and
the User ID includes a resource, the value from that ID is used. If both are specified, the value
from this Resource field is used. If no resource is specified, the XMPP server will assign a
temporary resource.
The priority, as per RFC 3921. The default is 0.
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SIP Accounts – General

Fields with an asterisk are
required

Table 2: Accounts – General
Field
Account name
Protocol
Use for Call
Use for IM/Presence

Description
If desired, change the account name to something that is meaningful to you. For example, the
name of the VoIP service provider.
Read-only. Always specifies SIP.
If checked, this account is eligible to be used for phone calls. If unchecked, this account will
never be used for placing phone calls.
If checked, this account is eligible to be used for IM and online status (presence). If
unchecked, this account will never be used for IM and online status.

User Details
User ID
Domain
Password
Display name

Typically the account number for the softphone account. For example, 6045551212 or 2766.
Provided by your VoIP service provider.
For example, domainA.com. Provided by your VoIP service provider.
Provided by your VoIP service provider.
This name is displayed in the Bria title bar.

Authorization name

Other people will see you as this name.
May not be required. If it is required, it will be provided by your VoIP service provider.

Domain Proxy
Register with domain and receive Check this box if you want to register with your VoIP service provider, so that you can receive
calls
incoming calls.
Typically, this field is checked.
This field must be left unchecked when, for example, your level of service does not include
the ability to receive incoming calls. In that case, turning this field on may cause registration
to fail (when you close the Account Properties window).
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Table 2: Accounts – General
Field
Send outbound via

Description
Choose the setting specified by your VoIP service provider:
• Domain: If your VoIP service provider requires that traffic be directed to proxies that are
discovered via the domain.
• Proxy Address: If your VoIP service provider has an outbound proxy address and requires
that you provide the address to Bria. For the address enter a domain name (for example,
domain.com) or an IP address (for example, 123.456.789.012).

Dial Plan

If you are using Bria in a test lab, it is possible that neither of these settings is suitable; see
page 60 for a third way to direct traffic.
Information about the syntax of the numbers used by this VoIP service provider.
Provided by the service provider. The default plan is:
#1\a\a.T;match=1;prestrip=2;
For information on determining whether you need to modify the default dial plan, see
page 78.
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SIP Accounts – Voicemail

These settings let you set up to interact with your VoIP service provider’s voicemail service. They also let you
configure Bria to forward calls in several situations, independent of your VoIP service provider’s voicemail
service.
Your service provider may provide the ability to set up for voicemail outside of Bria, for example, by phoning a
softphone address and following the voice prompts, or by accessing a website.
Check with your service provider to determine if another setup mechanism is available. If so, check what the
settings are in that setup, and make sure you enter compatible information in Bria.
In particular, if your service provider has a mechanism for call forwarding, find out if you should leave the
Forwarding settings on this Voicemail tab blank.
Table 3: Accounts – Voicemail
Field
Check for voicemail

Description
Set the checkbox in one of these ways:
• Check the box if Bria must subscribe to be notified when there is a voicemail for
you. In other words, to configure for “subscribe for message waiting”.
• Clear the checkbox if the service provider’s voicemail server sends notifications
without Bria subscribing. In other words, to configure for “implicit subscription”.
• Clear the checkbox if the service provider does not support voicemail.
Check with your VoIP service provider for the correct configuration.
Voicemail is offered by your VoIP service provider; it is not part of Bria. Contact your
service provider for information on using voicemail.
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Table 3: Accounts – Voicemail
Field
Number to dial for checking voicemail

Description
Optional, but complete this field only if your VoIP service includes voicemail.
• Completing this field activates the voicemail icon in the tool bar. When you click this
icon, Bria will dial this number. You will be connected to your service provider’s
voicemail and can listen to your messages.
• If you leave this field empty, then this icon will not work; you will have to manually
dial this number in order to connect to voicemail.

Number for sending calls to voicemail

Enter the number or SIP address provided by your VoIP service provider.
Complete only if your VoIP service includes voicemail. Optional, but you must
complete it if you check “Send calls to voicemail if unanswered”.
This is the number that incoming calls will be forwarded to if they are unanswered after
the specified interval (below).
If you leave this field empty, then Bria will never forward calls to your service
providers’ voicemail. However, most VoIP service providers have their own mechanism
for sending unanswered phone calls to voicemail. So leaving this field blank does not
mean that forward-to-voicemail does not work.

Send calls to voicemail if unanswered

Enter the number provided by your VoIP service provider.
Complete only if your VoIP service includes voicemail.
To send to voicemail after the specified number of seconds.

Always forward to this address

Your service provider may also provide a similar feature that is set up outside of Bria. If
so, make sure you do not enter competing information in Bria and in the service
provider’s user interface. For example, if you turn off this field, make sure the same
feature at your service provider is also turned off. Otherwise, all your calls will continue
to be forwarded.
You can use this feature even if your VoIP service does not include voicemail.
To always forward phone calls, click the box and enter the address to forward to. Phone
calls received on other accounts (if you have them) are not affected by enabling this
field.

When on the phone, forward to

Always forward works only when Bria is running and only if your VoIP service
provider supports redirect.
You can use this feature even if your VoIP service does not include voicemail.
To forward only when you are on another phone call, click the box and enter the address
to forward to. Phone calls received on other accounts (if you have them) are not affected
by enabling this field.
Always forward works only when Bria is running and only if your VoIP service
provider supports redirect.
Your service provider may provide a similar feature that is set up outside of Bria. If so,
make sure you do not enter competing information in Bria and in the service provider’s
user interface. For example, if you turn off this field, make sure the same feature at your
service provider is also turned off.
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SIP Accounts – Topology

Table 4: Accounts – Topology
Field
Firewall traversal
method

Description
Choose the setting recommended by your VoIP service provider:
• Auto detect using ICE: Automatically determine the contact address for signaling traffic.
Advertise the local IP, public IP (discovered via STUN, if available) and media relay IP and use these to
automatically determine the best route for media traffic during calls.
• Discover public IP address: Advertise the public IP address (discovered via STUN) for the contact
address for signaling traffic, and for the connection address for media traffic.
• Use media relay (TURN): Advertise the public IP address (discovered via STUN) for the contact address
for signaling traffic.
Advertise the address of a media relay server (discovered via TURN) for the connection address for
media traffic.

Server address

Range of ports

• None: Advertise the local IP address only for both signaling and media traffic.
• Empty: Discover the address of the firewall traversal server (the STUN or TURN server), if available,
using DNS SRV.
• Specified: Use the firewall traversal server specified as either an IP address or a fully qualified hostname.
If you use the “Auto detect using ICE” option, then you can only enter a STUN server here. Don’t enter
a TURN server because when ICE is used, TURN is not supported.
The appropriate setting depends on your computer setup:
• Checked: If your computer is behind a restrictive firewall that only allows specific port ranges to be
used. Enter the range of ports to use for your SIP account. (You must also open those ports on your
firewall; refer to applicable firewall documentation for information.)
• Unchecked: If your computer is not behind a restrictive firewall.

54

Bria 3 for Mac User Guide – Retail Deployments

SIP Accounts – Presence

Presence allows other softphone users to see your online status, and also allows you to see the online status of
others.
This tab lets you set up to share presence information with contacts. (Note that you do not have to set up to
share presence information on an XMPP account.)
Once you have configured presence on this page, you can set up rules; see “Sharing Online Status” on page 39
and “Preferences – Privacy” on page 62.
Table 5: Accounts – Presence
Field
Mode

Description
Choose the setting specified by your VoIP service provider:
• Disabled: Presence is not supported.
• Presence Agent.
• Peer-to-Peer.

Poll time

Enter the value specified by your VoIP service provider.

Refresh interval

Enter the value specified by your VoIP service provider.
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SIP Accounts – Storage

Typically, you leave the storage method as Local. However, if your VoIP service provider provides access to an
XCap or WebDav server, you can choose to store some contact data on that server.
Contact data gets stored on the server as follows:
•
•
•

Softphone numbers and display names from contacts created manually or from a corporate directory or by
importing from a file.
Other data from these contacts does not get stored on this server.
XMPP contact data does not get stored on this server.
Table 6: SIP Accounts – Storage
Field

Storage method

Description
The storage method to be used for the buddy list and presence rules. The file can be stored
locally (choose Local) or both locally and on a remote computer (choose one of the other
options).

Server Settings (not used for “Local”)
Use SIP credentials

Use alternative server credentials

56

Check this box to use the username and password from your SIP account in order to log into
the storage server.
Otherwise, uncheck this box and complete the Username and Password fields.
Check this box to use specific credentials. Enter data for connecting to the server.
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SIP Accounts – Transport

Table 7: SIP Accounts – Transport
Field
Signaling Transport

Encryption
Allow IPv6

Description
Contact your VoIP service provider to identify the types of transport that are supported.
Then choose a supported transport:
• Automatic: Bria sets up the transport based on the capabilities of the network and the
Bria computer. Choose this option if you do not care which transport is used.
• TCP: This transport provides no signaling security.
• UDP: This transport provides no signaling security.
• TLS: Choose this option to request signaling encryption or both signaling and media
encryption.
See the description below for more information.
Enable to allow Bria to make phone calls and send IMs over IPv6. Disable only if advised to
do so by your system administrator.Generally, leave this enabled. Disable it only if advised
to do so by your VoIP service provider.

You can set up Bria for the type of security (encryption) you want for incoming and outgoing calls.
Bria supports:
• Signaling encryption using TLS
• Media encryption using SRTP.
Setting up for Security outside of Bria

When using TLS, you must have the root certificate that signs the proxy's chain of certificates. In most cases,
the root certification will already be installed. Procedures for the exchange of certificates are outside the scope
of this documentation. The certificates must be stored on the Bria computer, in the root certificate store.
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Setting up the root certificate on your computer ensures that the connection to the proxy is TLS secure (the first
hop). Any proxy in the chain (between you and the caller) that does not support TLS may cause an insecure link
in the chain. Therefore, if the other party is outside your domain, you cannot be completely sure that the call is
secured at the signaling level, which means that you cannot be sure that it is secured at the media level.
Setting up for Security within Bria

The options for media encryption are described in the following table.
Table 8: Security Options
Option
Make and accept only
encrypted calls

Do not allow encrypted
call
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How Outgoing Calls are Handled

How Incoming Calls Are Handled

Bria will place all calls with TLS. The call INVITE Bria will only accept INVITEs that are for
encrypted calls.
will specify SRTP media encryption.
If the correct certificates are not in place or if the If Bria receives a call INVITE that is not
other party does not accept encrypted calls, the call encrypted, the call will be rejected.
will fail.
Bria will place only unencrypted calls.
Bria will only accept INVITEs that are for
unencrypted
calls.
If the other party does not accept unencrypted
calls, the call will fail.
If Bria receives a call INVITE that is encrypted, the
call will be rejected.
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SIP Accounts – Advanced

Table 9: SIP Accounts – Advanced
Field

Description

Register Settings
Reregister every

Minimum time

Maximum time

The time interval between Bria’s attempts to reregister in order to refresh the account registration
with the VoIP service provider for this account. A value of zero means not to reregister after the
initial registration.
This value is placed in the “Expires” header field of the REGISTER message.
If the reregistration fails, Bria will wait this amount of time, then attempt to reregister. If the
second attempt fails, Bria will wait twice this time and try again, then four times this time, and so
on, until reregistration succeeds.
This is the maximum wait time between attempts to reregister. Once this maximum is reached,
Bria will wait this time for all subsequent attempts.
For example, the min. time is 20 secs, the maximum time is 120 secs. Bria will attempt to
reregister as follows:
•
•
•
•
•
•
•
•
•

Wait 20 secs.
Attempt to connect.
If fail, wait 40 secs.
Attempt to connect.
If fail, wait 80 secs.
Attempt to connect.
If fail, wait 120 secs (the maximum)
Attempt to connect.
If fail, wait 120 secs, and so on.
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Table 9: SIP Accounts – Advanced
Field

Description

Timers
Enable session timers
Default session time

Session timer preference

A session timer is a mechanism to detect whether a call session is still active from the signaling
point of view. When the timer expires, a refresh is sent from one party to the other. The timer is
then reset.
• Turn on to enable session timer. Enter a value in Default session time.
• Turn off to disable session timer; refreshes will never be sent.
This field specifies your preference for which party should send the refresh. The preference is not
a guarantee that the refresh will be performed by the specified party. The choices are:
•
•
•
•

Send SIP keep-alives
Use rport
Send outgoing request
directly to target

Use old style hold
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None: No preference.
Local refreshes: Your computer sends.
Remote refreshes: The other party sends.
UAC refreshes: The user agent client (the party that initiated establishment of the
communications) sends.
• UAS refreshes: The user agent server (the other party) sends.
Typically on, to instruct Bria to send SIP keep-alive messages in order to maintain a “pinhole”
through your firewall for SIP messaging.
Typically on.
When checked, requests with a complete URI (user@ABC.com) go to ABC.com and the “Send
outbound via” field on the General tab (page 50) is ignored.
If you check this field, make sure you also set “Send outbound via” (on the General tab) to
“Domain”.
Typically off. This field is intended for test labs and may cause problems in a NAT environment.
Check this box only if your VoIP service provider advises you to do so.
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7.2 General Preferences
From the menu bar, choose Bria > Preferences. The Preferences window appears. All the tabs on this window
except for “Accounts” are preferences tabs. These tabs let you control the way that you work with Bria.
The icons (other than Accounts) let you set up general features of Bria.

Preferences – Application

This panel lets you set your preferences for general GUI behavior and lets you set up for login.

Login Options
Login is typically used only in enterprises. You should not enable login.
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Preferences – Privacy

You can control how contacts and other people can contact you by phone or IM, and you can control whether
your contacts can see your presence information (whether you are online, on the phone, and so on).
General Tab

In “Global Contact Settings”, choose one option. If you choose “Only people in my contact list”, then all
contacts will be able to contact you unless their name or their domain is in the Blocked list (below).
The “Blocked” section is optional. It lets you enter addresses and domains that will be prevented from
contacting you.
You can add and remove entries from the blocked lists. In addition, entries are automatically added to this list
when you block someone “on the fly” (page 43).
Corporate Tab

If you enter a domain in this list, people in that domain will automatically be allowed to see your online status.
You will no longer see Presence Request dialogs from these people in this domain.
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Preferences – Alerts & Sounds

This panel lets you control the alert box and lets you assign sounds.
Enable Alert Displays

You can control whether the Call Alert box is displayed in
different situations. You can also control how you are
alerted to an incoming IM: either with a small IM Alert
box or with the IM window itself.
Assigning Sounds

You can assign specific sounds to a variety of actions or “events”.
1. Select the Enable sounds check box and select the check boxes for each desired event, or clear the Enable
sounds check box to disable all sounds.
2. If enabling sounds, you can change the sound for each event: select the individual event. The value in
Sound preference will change. Select the desired sound.
You can import sounds; these will be added to the list of sounds you can choose from when assigning a sound to
an event.
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Preferences – Devices

Bria automatically detects devices at each startup, and selects the most appropriate device for each purpose. If
you do not like this selection, you can override it on this panel.
If you override a selection, it will apply the next time you start Bria, unless the device is no longer available, in
which case Bria will again select the device to use.
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Field

Description

Headset Mode
Microphone,
Speaker

Change these fields only if you want to override the devices that Bria automatically selected.
In both these fields, select the headset you are using.
The headset is the device that is usually used for the speaker (the sound you hear) and microphone
(recording your voice). The only situation in which the headset is not used is when the Speaker
Phone button on the dialpad is pressed.
Therefore, unless you will always be using Bria in speakerphone mode, you must make a selection
here.
Select the headset in both the Speaker device field and Microphone device field.

Zero touch device
configuration

Typically, leave on. When device configuration is on, if you change your audio or video device,
Bria will automatically detect the new device and start using it.

Test Devices

For information on the Test Devices button, see “Troubleshooting” on page 73.

Speakerphone Mode
Microphone

Same as headset mode, but for the device to use when speakerphone is one (on the toolbar).

Speaker

Select None if you do not have a speaker phone. The Speaker Phone button on the dialpad will be
disabled.
You can set different devices for the speaker and microphone: for example, you can set the speaker
to the speakerphone and set the microphone to your headset.

Other Devices
Ring on

The device where you want to hear the phone ringing.
Change this field only if you want to override the devices that Bria automatically selected.

Volume
Camera

The volume of the ringer.
This field appears only on versions of Bria that include video functionality.
Change this field only if you want to override the devices that Bria automatically selected.
Select the camera model.

Resolution

Leave at standard, or change the size as follows:
• Set it to high if you have a good camera and a computer with a fast CPU. You will know that you
have set the size too large if:
Your computer slows down (the video is using too much CPU)
The video shows black areas or is slow or jerky.
• Typically set it to low only in special situations, for example, when using wi-fi in a hotel. You
will know that you have set the size too small if the video is fuzzy.
This field is identical to the Resolution field in Media Quality > Video Quality.

Deskphone Setup

Typically, deskphones are used only in enterprises.
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Preferences – Network

Select the type of network connection for your computer.
The sliders move to show the bitrate that will be used for sending and receiving. These rates are typical rates for
the selected configuration.
If you know that your computer and network can handle a faster sending speed, click Custom and move the
slider. It is recommended that you not change the receiving speed.
•
•

•
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You will know that you have set the sending speed too high if the remote audio is garbled.
You will know that you have set the sending speed too high if:
• The remote video shows black areas or is slow or jerky.
• The remote audio is garbled.
You will know that you have set the sending speed too low if the audio is good but the video is of poor
quality (grainy).

Bria 3 for Mac User Guide – Retail Deployments

Preferences – Codecs
Audio Codecs

This panel shows all the codecs that are included in the retail version of Bria. You can enable or disable codecs
as desired.
With only one codec enabled, all calls made will use that codec. With more than one codec enabled, Bria
automatically chooses the best codec based on the other party’s capability, the available bandwidth, and
network conditions.
You cannot change the properties of any codecs.
About Codecs

Audio codecs describe the format by which audio streams are compressed for transmission over networks.
Codecs can be categorized as either narrowband or wideband:
•
•

Narrowband codecs work with low bandwidth such as a dialup internet connection. These codecs have a
sampling rate of 8 kHz.
Wideband codecs work with high bandwidths and result in better audio quality. However, they do not work
with PSTN. These codecs have a sampling rate of 16 kHz.
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Supported Codecs
Codec

Narrowband

Wideband

AMR Wideband (G.722.2)

3

Broadvoice-32

3

Broadvoice-32 FEC

3

DVI4

3

3

3
3

DVI4 Wideband

Included in
Retail Bria

Royalty-bearing

3

EVRC

3

3

G.711aLaw *

3

3

G.711uLaw *

3

3
3

G.722

3

G.723

3

3

G.726

3

3

G.729 *

3

3

GSM

3

3

iLBC

3

3

L16 PCM Wideband

3

3

Speex

3

3

Speex FEC

3

3

3

Speex Wideband

3

3

Speex Wideband FEC

3

3

* Generally, at least one of these codecs must be enabled in order to place a PSTN (land line) call.

68

Bria 3 for Mac User Guide – Retail Deployments

Video Codecs

Video codecs describe the format by which video streams are compressed for transmission over networks.
Some codecs require less bandwidth than others, but may result in lower video quality.
You can enable or disable codecs as desired. You may decide to disable a codec even though your VoIP service
provider supports it.
With only one codec enabled, all calls made will use that particular compression format. With more than one
codec enabled, Bria automatically chooses the best codec based on the other party’s capability, the available
bandwidth, and network conditions.
You cannot change the properties of any codecs.
Supported Codecs

•
•
•

H.263
H.263+1998
H.264

69

CounterPath Corporation

Preferences – Media Quality

Field

Description

Audio Quality
Reduce echo
Reduce background noise

Turning this feature on improves sound quality. This feature is typically on.
Automatically attempts to remove background noise.
Typically on for the speakerphone.

Automatic gain control

This feature is typically on.

Preserve bandwidth

When this feature is on, Bria stops sending audio when you are not talking.
When this feature is off, Bria always sends audio, which uses more bandwidth but may result in
better call quality.
Typically off. However, if you are using a slow (dial-up or ISDN) connection, you may want to turn
it on.

Video Quality
Resolution

Leave at standard, or change the size as follows:
• Set it to high if you have a good camera and a computer with a fast CPU. You will know that you
have set the size too large if:
Your computer slows down (the video is using too much CPU)
The video shows black areas or is slow or jerky.
• Typically set it to low only in special situations, for example, when using wi-fi in a hotel. You
will know that you have set the size too small if the video is fuzzy.
This field is identical to the Resolution field in Devices > Other Devices.
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Preferences – Call Automation
These settings let you configure how you want auto answer to handle incoming calls, when Auto Answer is
enabled. (To enable Auto Answer, see page 15).

Preferences – Directory

Typically, directories are used only in enterprises and are set up by the system administrator.
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Preferences – Advanced

Field

Description

Audio
DTMF

You may need to change the DTMF configuration if you cannot interact with interactive voice
response systems (auto attendants, voice-activated menus, and so on).
Contact your VoIP service provider for the correct setting.

RTP

This timer controls how calls are disconnected when Bria determines that there is a problem with
the call and the other party has probably disappeared (assuming that you have not yourself
detected the problem and hung up manually).
Typically, the timer is enabled. It is recommended that you not disable it.
You can change the length of the timer, but do not set it to less than 30 seconds.

Call Recording

The folder where files for recording of phone calls will be saved.

File Transfer

The folder where received files will be saved.

Web Page Tabs

You can set up a web page as a new tab in the Resources panel; it will appear alongside
Contacts, History and so on.
Enter the web address and a name (this name will be appear in the tab). Enter a checkbox to
create the tab.
At any time, you can clear the checkbox to remove the tab from the Resources panel.
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A Troubleshooting
From the menu bar, choose Help > Troubleshooting. The Troubleshooting window appears.

Testing Audio Quality
While you are on a phone call, you can test the quality of the audio. Note that to perform a valid test, you should
be on an established call (not a call attempt).
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Testing Video Quality
While you are on a phone call, you can test the quality of the video. Note that to perform a valid test, you should
be on an established call (not a call attempt).
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Testing the Network Connection
You can verify that you are successfully connected to the network.
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Testing Audio Devices
You can verify that your microphone and speakers are working and can set the volume to a comfortable level
without having to actually place a phone call.
F
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Diagnostics
Only use this panel if instructed to do so by customer support.

To start logging Bria activity and send a logging report to CounterPath customer support:
1. Click Start Logging. The first Diagnostics Logging window appears.
2. Select the problem you are experiencing and click Start Logging.
3. On the second Diagnostics Logging screen, click Finish. Logging will start.
4. Perform the actions you want to capture; for example, attempt to make a phone call.
5. When done, display the first Diagnostics Logging window again and click Send Report. A window opens;
select the report and click Open. When the report is successfully sent, a confirmation message appears on
the first Diagnostics window.
6. Click Stop Logging. Close the Troubleshooting window.
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B Dial Plan
When a call attempt is made, the call input (what you type, select or drag onto the call entry field) is processed
to select the SIP account to use and to modify the input if that is required to ensure that the call gets placed
successfully. This ability to select an account and modify the input relies on the existence of a “dial plan” for
each account.

Do You Need to Read this Information?
You do not have to read this dial plan information if the default dial plan behavior (below) is acceptable.
If you want to be able to place calls on a specific account without including the account prefix, then you must
create a dial plan for one or more accounts.
The default dial plan is:
#n\a\a.T;match=1;prestrip=2;
where #n is the account prefix (#1 for the first account in the list (proxy0), #2 for the second account (proxy1),
and so on).
If the input is the account prefix and the number, then the Account for this dial plan is selected. The account
prefixed is stripped from the number before the call is placed.
If all Accounts use this dial plan, then the behavior is as follows: if the input includes the account, then that
account is used. In other words, you can force selection of a specific account by including the account prefix. If
the input does not include #n, then the default account is used.

Processing of Phone Numbers when a Phonecall is Placed
When a phone call is placed, the input (the phone number or SIP address) is processed as follows:
•
•

Cleanup: Input is cleaned up by removing spaces, dashes, open brackets, and close brackets.
Matching: The input is compared to the patterns defined by the dial plan for each enabled account. Each
account has one dial plan, and each dial plan has one or more patterns.
When a match is found between the input and the pattern, the account that this pattern belongs to is selected
and the transformation for this pattern is performed.
If no match is found, the default account is selected and no transformation is performed.
For details on matching see “How the Input Is Processed” on page 81.

•
•
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Transformation: The selected transformation is performed.
Then the call is placed using the transformed input.
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B.1 Dial Plan Syntax
In Bria, the dial plan establishes the expected patterns of characters for a telephone number or softphone
address, and allows for modification (transformation) of input based on the match to a pattern. The dial plan has
the following syntax:
pattern[|pattern];match=1;<transformation>=<value>;[match=2;
<transformation>=<value>;]
Where:
•
•
•

Items in [ ] are optional.
Pattern: the pattern that will be matched. One or more patterns. Each pattern is separated by a | pipe. The
pipe is optional after the last pattern. Each pattern is implicitly numbered, starting from 1.
Match; Transformation: A pair that identifies the pattern number to compare with the input, and the
transformation to perform on the input when a match is obtained. The transformation is optional (meaning
that if there is no transformation for a pattern, then the input that matches this pattern is not transformed).
One or more pairs.
“match=” is a literal. “n” identifies the pattern. “transformation=” is replaced by a keyword, see below.
“value” is replaced by a value.
Spaces are allowed only in the <value> items.

Example
\a\a.T|xxxxxxxxxx;match=1;prestrip=2;match=2;pre=8;
where:
•
•
•
•

\a\a.Tis the first pattern.
xxxxxxxxxx;is the second pattern.
match=1;prestrip=2;is the first match-transformation pair.
match=2;pre=8;is the second match-transformation pair.

Pattern
Valid Content

The content for a pattern follows the digit map rules of RFC 2705, supplemented by the rules for regular
expressions. Where there is an overlap between the digit map and regular expression rules, the digit map rules
apply. For this reason, there are some special cases, included in the table below.
The following table describes the most common elements. As mentioned, all regular expression elements are
supported.
Element

Origin

0 1 2 3 4 5 6 7 8 9 Literals
# * a to z

Literals

Description
Literal digits, used as is.
Literal characters, used as is. Special cases:
• The literal x character is represented by \x.
• The literal t character is represented by \t.

x

Digit map rules

Wildcard for any single digit, 0 to 9.
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Element

Origin

Description

\a

Regular
expression rules

Wildcard for any single alphanumeric character.

[digit-digit]

Regular
expression rules

A digit within the specified range.

[charactercharacter]

Regular
expression rules

A character within the specified range.

[digit1, digit2,
digit3]

Regular
expression rules

One of the characters in the collection.

.

Digit map rules

Repeat the last element 0 or more times. For example, xxxx. means repeat the last x 0 or
more times, which means this pattern matches three or more digits (not four or more
digits)! Use of this element results in a pattern with “minimum requirements”.

T

Digit map rules

A timeout period will take place before automatic dialing starts.
The T timer forces Bria to wait after a match is made. This timer should always be
included in these situations:
• Any pattern that uses the . (dot). For example, if the pattern is xxxx. then adding a
timer lets you type three or more digits. If there is no timer, then as soon as you type
three digits, Bria makes the match as soon as you type three digits.
• Any dial plan that has two patterns that are similar in elements but different in length.
For example, if one pattern is xxx and the other pattern is xxxxxxx, then adding the
timer lets you continue typing past three digits, in order to get a match on the second
pattern.
In this situation, the T timer should be included in the shorter pattern.

Timers

There are two timers:
•
•

T timer is 4 seconds.
The long timer is 20 seconds.

These timers are used in input comparison, as described in “How the Input Is Processed” on page 81.

Transformation Keywords
Keyword

Description

prestrip

Strip the first n characters from the input before
placing the call.

poststrip

Remove n number of characters from the end of
the input before placing the call.

pre

Add the specified account prefix to the input
before placing the call.

post

Attach the specified postfix to the input before
placing the call.

replace

Replaces the input with the specified string
before placing the call.

Order of Transformations

These transformations are always performed in the following order (the order in which the transformations are
entered in the dial plan is not significant):
prestrip > poststrip > pre > post > replace
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B.2 How the Input Is Processed
Comparing Input to the Dial Plan Patterns
The input is compared to each dial plan in turn, starting with the first listed account. The process is slightly
different depending on how the call is placed:
•

•

If the input was dragged or selected, then the entire input is compared to each dial plan. If a complete match
is found, then that account is selected and the associated transformation is performed. If no match is found,
the default account is selected and no transformation is performed.
If you are typing the input, the digits are compared one by one as they are entered. The comparison will
result in one of the types of matches described in the table below.

It is possible for the same input to get matched to different dial plans depending on whether the input is entered
on the fly or dragged. It is important to keep this in mind when designing dial plan patterns.

Results of the Comparison
Type of Match

Conditions

Result if You Press
Enter or Dial

Result if You Stop Typing

Partial match

If you stop typing for the long
The characters typed so far follow the pattern but The default account is
there are not yet enough characters for a pending selected. No transformation timer length (20 seconds), then
the default account is selected.
is performed.
or complete match.
No transformation is
performed on the characters
typed so far.

Pending match

• The pattern has no . (dot) but does have the T
timer. There is a perfect match.
• The pattern has a . (dot) and the T timer. The
minimum requirements are met.

This pattern's account is
selected and the
transformation is
performed.

If the T timer expires, this
pattern's account is selected
and the transformation is
performed.

Complete match • The pattern has no . (dot) and no T timer.
There is a perfect match.
• The pattern has a . (dot) but does not have the
T timer. The minimum requirements are met.

This pattern's account is
This pattern's account is
selected and the associated selected and the associated
transformation is performed.
transformation is
performed.

No match

The default account is
selected and no
transformation is
performed.

The characters typed do not match the patterns
for any dial plan.

Nothing happens even after the
T timer and long timer have
expired.
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B.3 Examples
Example 1
\a\a.T|xxxxxxx.T;match=2;pre="9"
This simple example shows how to differentiate between a PSTN number and a softphone address, and how to
add a “9” dialing prefix only to the PSTN number.

Example 2
3xxT|1xxxxxxxxxx|[2-9]xxxxxxxxx|+x.T;match=2;pre="9";
match=3;pre="91";match=4;prestrip=1;pre="9011"
3xxT

The first pattern is any three-digit number beginning with 3. No transformation. The
assumption is that this is an internal extension. The timer forces Bria to wait after detecting a
three-digit number beginning with 3, in case you are actually dialing a local call starting with
3.

1xxxxxxxxxx

The second pattern is any eleven-digit number beginning with 1. Prefix with 9 and dial as is.
The assumption is that this is a long-distance PSTN call within North America (within North
America, all long-distance calls start with 1).

[2-9]xxxxxxxxx

The third pattern is any ten-digit number beginning with a number other than 1. The
assumption is that this is a local PSTN call within a ten-digit dialing zone.

+x.T;

The fourth pattern is a number of any length that begins with +, to indicate an international
PSTN call from North America. Delete the +, prefix with 9011 (011 is the number to access
an international line from North America).

match=2;pre="9";

For the second pattern, prefix 9 to access an outside line.

match=3;pre="91";

For the third pattern, prefix 9 and 1 to access an outside line and enter the long-distance code.

match=4;prestrip=1;pre="9011"

For the fourth pattern, remove the + and prefix 9011 to access an outside line and enter the
international code.

Example 3
#1xxxxxxxT|#19xxxxxxx|xxxxxxxT|9xxxxxxx|;match=1;prestrip=2;pre=9;match=2;
prestrip=2;match=3;pre=9;
#1xxxxxxxT

The pattern is an account prefix followed by seven digits. The timer forces Bria to wait to
allow a match to the second pattern. The #1 is stripped off and 9 is prepended to access an
outside line.

#19xxxxxxx

The pattern is an account prefix followed by a 9 and seven digits. The #1 is stripped off.

xxxxxxxT

The pattern is seven digits. The timer forces Bria to wait to allow matching to the fourth
pattern. 9 is prepended to access an outside line.

9xxxxxxx

The pattern is a 9 and seven digits. The input is not transformed.

This example assumes that the dial plan belongs to the first account.
The dial plan is slightly trivial, because it does not cover all the situations that a dial plan should be designed for
(local calls, long-distance calls, international calls, and so on for the locale).
However, the example does illustrate two ideas:
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•

Handling of the account prefix (#1), if you are upgrading from Bria 1.1 and are accustomed to entering the
account number.
Use of # to identify the account is now deprecated. The dial plan should be capable of determining the
account to use for this number. However, since users may still be in the habit of entering the account prefix,
you may want to include this pattern to handle such a scenario.

•

Distinguishing between a local seven-digit call in which 9 is not dialed (to access an outside line) and one
in which 9 is dialed to access an outside line.
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C Contact List Headings
Following is a list of all the headings that are used in the Bria contact list. This list can be useful when
formatting a contact list in order to import it into Bria. For details, see “Populating by Importing Contacts” on
page 33.
s

Heading

Description

business_number
business_numbern, where n is 2 to 6
categories

Maps to Bria groups

default_address

Maps to the Presence field

default_address_comm

Always specifies IM, if default_address is specified. This
heading does not map to a Contact Profile field

default_address_type

Specifies SIP or XMPP

display-name
email_address
email_addressn, where n is 2 to 6
fax_number
fax_numbern, where n is 2 to 6
given_name
home_number
home_numbern, where n is 2 to 6
mobile_number
mobile_numbern, where n is 2 to 6
other_address
other_addressn, where n is 2 to 6
postal_address
presence_subscription

TRUE or FALSE

sip_address

Maps to the Softphone field.

sip_addressn, where n is 2 to 6
surname
web_page
web_pagen, where n is 2 to 6
xmpp_address
xmpp_addressn, where n is 2 to 6
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Maps to the Instant Message field. This field must always
specify an XMPP address
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D Glossary
Broadband

Codec
Dial plan

DTMF

Firewall
IM
MWI
Narrowband

Presence
PSTN
SIP account
Softphone address
USB device

vCard
VoIP service provider

Broad or wide bandwidth. In data transmission, the wider the band, the more data it is
possible to transmit in a given time span. A cable, DSL and ADSL connection to the
network provide broadband for data transmission. A dialup or ISDN connection
typically provide a narrow bandwidth for data transmission.
The format by which audio or video streams are compressed for transmission over
networks.
The rules that Bria follows in order to interpret the softphone address or phone
number that the user has entered and to modify the number or address, as required, to
ensure that the call will be placed successfully.
Dual-tone multi frequency. DTMF is the system that is used in interactive voiceresponse menu systems such as the menu system for accessing voicemail messages.
The DTMF system allows the user to interact with the menu by pressing keys on a
dialpad or keyboard.
A technology that prevents unauthorized people connecting to your computer and to
the applications running on the computer.
Instant Messaging. A technology that lets users send text message and files for near
instantaneous delivery and display on each others’ computers.
Message Waiting Indicator. An indicator that there is a voicemail message for the
owner of an account.
In data transmission, the wider the band, the more data it is possible to transmit in a
given time span. A cable, DSL and ADSL connection to the network provide
broadband for data transmission. A dialup or ISDN connection typically provide a
narrow bandwidth for data transmission.
An instant messaging feature that allows users to share information about their online
status.
Public Switch Telephone Network. The traditional land-line phone network.
An account that provides the user the ability to make VoIP phone calls. The account
encapsulates the rules and functions the user can access.
The address used to connect to a SIP endpoint. In other words, the “phone number”
used in a VoIP phone call. For example, sip:joseph@domainA.com.
Universal Serial Bus device. A device that follows a specific communications VoIP
Voice over Internet Protocol. A variation of IP used for sending voice data over the
internet, in other words, used for making phone calls over the internet.
An electronic business card that is often attached to an e-mail. It often appears as a
“signature block” that identifies the person, their title, and their business.
A business that provides a VoIP service, allowing a user to connect to the internet in
order to make VoIP phone calls using Bria. The VoIP service provider sets up a SIP
account for the user.
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